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Scripting: What? Why? How?

Plugins
- = programming
- Require java programming knowledge
- infinite possibilities
- Library compatible (once a class is written, it can be 

exchanged/used anywhere)

What is an ImageJ script?

A script is a recipe
=  an algorithm that automates a series of (repetitive) ImageJ commands. 
In essence: a text file with a sequence of commands.

Macros
- easier: automation of tasks... And documentation, 
- not so easy to exchange because of missing libraries
- Much easier and lighter (scripting vs programming)
- Relatively slow (~40x slower than plugins)
- Limited real-time interaction: a macro is a train that rolls, and rolls, and rolls...
- No extendability (no use in other software)

Why writing scripts/Macros?
Scripts make your life easier



Learning Imagej macro scripting

Advantages of ImageJ macros over other languages/plugins:
- Easy to learn since commands are mirrors of the GUI functions
- No need to understand java, Python, C++, …

How to write ImageJ macros
- Fiji has a IDE (integrated development environment): editor with syntax highlighter, command auto-completion, ...
- ImageJ has not such features

Both Fiji and ImageJ can record a macro = recording the sequence of clicks in ImageJ



Recording a macro

EXERCISE
Use the macro recorder

Plugins > macro > record...

Open example 1 (A, lena or B, Fabio)
Adjust brightness and contrast (use ‘set’ in Contrast & Brightness)
Invert the image (Edit > Invert)

In the Recorder: click «Create»

Close all images. In the created macro window: click «run»



Recording a macro

EXERCISE
 See how the macro recorder works

Close all images. 

Macro.ijm > click run

Automatically opens example 1 (lena or Fabio)
Automatically adjusts brightness and contrast
Inverts the image

The recorder will:

- Turn graphical commands (GUI) to code
- Keep track of what you do to your image (=log)



The print command

1. Open a new script window
In Fiji: File > New > Script... A new window opens, named «New_» 

2. Set the language
In the Editor: Language > IJ1 macro (note: in the recorder, the macro language was set as default)

3. Write a line of code, e.g. :

! Do not ignore lowercase (print is not the same as Print or PRINT)
! watch the quotation marks ‘’ ‘’ 
! and the semicolon at the end (=end of command)... They are all important

4. Automatically, the syntax highlighter will:
- Put «print» in dark yellow: it is recognized as a valid command
- (‘’hello world’’) in pink: it is recognized as text
- If this does not happen, you forgot point 2, setting the language

Now click «run»



The print command

EXERCISE
The “Hello world” script 

Result:

Script.ijm: Line 1-12

Note: you can also use other words than «Hello world» ☺



Running / debugging the script

Find the prepared script.ijm on the website

To run the entire script (everything), click «run» (don’t do this now!!)
To run part of the script, select the lines you want to include and hit CTRL+SHIFT+R (or Run > Run selected code)



Variables and strings

EXERCISE
Combining text variables

In the Editor:
Write:

Variables are typeless (no need to declare integers, bytes, ...)
Variables can contain

- letters and text (=string)
- a number (integer, double, float)
- a boolean (true/false)
- an array (= a list of variables)

Case sensitive! (the variable AMI is not the same as Ami)



Using variables

The statements in the commands can be fitted with variables. In short, the options must be a text form that is understood by the command.
e.g. 

Note the difference between text (=string, between ‘’ ‘’) and variables 
- Text must always be between ‘’ ‘’
- Variables not (try it)
- Plus (+) strings numbers and text together
- The sentence is read from left to right (you can perform calculation on the variables during concatenation)

Alternatively:



Arrays

An array is a list of variables. It can contain numbers, strings (text) or both.

Arrays have powerful methods:
- Find min, max, mean, mode, median, & maxima/minima (not just max/min!) in a numerical array
- Sorting (alphabetically)
- Find fourier amplitudes
- Rank positions
- Get Vertex positions (assuming the array describes positions on a closed contour)

Script.ijm: Line 27-37



Build-in Functions:

There are many build-in functions:  help > Macro functions ... http://rsb.info.nih.gov/ij/developer/macro/functions.html



Functions

You can also make functions yourself:

1. ‘sumTheseValues’ is called
2. The two variables Value1 and Value2 are send to the function (accepted as variable «one» and «two»). 
3. Within the function (defined by {}), some lines can be written
4. The result is returned to the main code

Script.ijm: Line 39-49



Comments

When you read your code again later (or much later), you want to understand what your code does, and why. For this, you can add comments, i.e. text which is 
ignored by ImageJ when it executes the macro.

Use // in front of the line. ; at the end is not needed. 
The entire line will be ignored by the interpreter.
e.g. Line 46

For multiline comments (eg line 43-90):
Use ‘/*’. Close the section off by ‘*/’



Something useful…

Try to make a Sobel filter yourself.
Use the recorder!

EXERCISE



Something useful…

Try to make a Sobel filter yourself.

EXERCISE

Lines 93-120



Conditional code

To execute a part of the code if and only if a certain condition is met:

<, <= less than, less than or equal

>, >= greater than, greater than or equal

==, != equal, not equal

&& boolean AND

|| boolean OR

Note the ==, it is not = (that would be an assingment, which 
does not make sense 
here). Operators:

Lines 124-139



Loops
To repeat instructions several times, loops are used. 

for - runs a block of code a specified number of times 
while - repeatedly runs a block of code while (as long as) a condition is true 
do...while - runs a block of code once then repeats while a condition is true 

Evaluate
condition

Statements

true false

Statements

false

true

Evaluate
conditionStatements

false

true

X ++

X < 
defined 
variable



FOR Loops

for  
This loop is a good choice when the number of repetitions is known, or can be supplied aforehand by the user.

for (initialization; condition; increment) {
statement(s);

}

Output: Output:

Lines 186-195



WHILE Loops

the loop must repeat until a certain "condition" is met.  If the "condition" is FALSE at the beginning of the loop, the loop is never executed.

while (condition) {
statement(s);

}

Lines 198-204



DO Loops

Same concept as the while loop except that the do-while will always execute the body of the loop at least one time.
Do-while is an exit-condition loop: the condition is checked at the end of the loop.

This looping process is a good choice when you are asking a question, whose answer will determine if the loop is repeated.

do {
statement(s);

} while (condition);

Lines 207-214



Point operations
}

EXERCISE
Open an grayscale image and invert the image by a script (do not use  the internal invert function).

You now know already enough to write a first simple script. 

- Iterate through all pixels in the image to invert the 8 bit image. Obviously, you are not allowed to 
use the run(«invert») command.

- Suggestions:
- Use a loop
- getPixel, setPixel
- getDimensions



Point operations

You now know already enough to write a first simple script. Iterate through all pixels in the image to invert the 8 bit 
image. Combine the following:

EXERCISE
Open an grayscale image and invert the image by a script (do not use  the internal invert function).

Lines 216-228



Result table functions

getResult («Column name», row number)
Will get a value from the result table (assumed there is one).

E.g. After running the «Measure particle« routine:

Result: 1716.88697 

print(getResult(“X”, 3006));



A propos: arrays

EXERCISE
Try to find the mean and the median value of the particle measurement of Figure 11

Median: use an array. 
- Store all values (Feret) in one array
- Sort the array
- Pick out the middle value (=median)

Mean: sum all values and devide by the total number of values. 
- Sum all values (Feret) in one variable
- Divide by the length of the table: nResults



A propos: arrays

EXERCISE
Try to find the mean and the median value of the particle measurement of Figure 11

Median: use an array. 
- Store all values (Feret) in one array
- Sort the array
- Pick out the middle value (=median)

Mean: sum all values and devide by the total number of values. 
- Sum all values (Feret) in one variable
- Divide by the length of the table: nResults

Lines 218-236



Remark

Commands, variables, arrays, loops and  conditionals are not exclusive to FIJI/ImageJ!!
- All programming languages have them
- The concept is usually the same, but the syntax may differ

String[] fruits = {“apple", “banana", “cherry"};
for (String i : fruits) {
  System.out.println(i);
}
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A very short intro into R/Rstudio

Why? And Why R… I am fine with Excel!

Natural science: Data > Information > Knowledge

There is increasingly more emphasis on the first step: from data to information. Aka Data analysis

R:
- Is a great resource for data analysis, data visualization, data science and machine learning
- provides many statistical techniques (such as statistical tests, classification, clustering and data reduction)
- is easy to draw graphs in R, like pie charts, histograms, box plot, scatter plot, etc++
- works on different platforms (Windows, Mac, Linux)
- Is open-source and free
- has a large community support
- has many packages (libraries of functions) that can be used to solve different problems



A very short intro into R/Rstudio

The Reinhart-Rogoff error
(leading to wrong austerity conclusions)



A very short intro into R/Rstudio

Install
Install R: https://cran.rstudio.com (base package)  

console

Environment

Output (plots)

Scripts

Install Rstudio: https://rstudio.com

https://cran.rstudio.com/
https://rstudio.com/


Assigning variables syntax

Vec <- vector(mode = "logical", length = 3)

FALSE FALSE FALSE

Vectors
Similar to arrays in FIJI: A 1-D list of 
arguments

Mat <- matrix(1:9, ncol= 3)

Matrices
A 2D list of arguments. All 
columns in a matrix must 
have the same length & 
mode (numeric, logic, …)

Arr <- array(1:4, c(3,2,2))

Arrays
A nD list of arguments 
Arrays can have more than 
two dimensions. 

d <- data.frame(letters[1:3], 1:3)
colnames(d) <- c("letters", "numbers")

Data Frames
A data frame is more general than a 
matrix, in that different columns can have 
different modes (numeric, character, 
factor, etc.). Columns can also get headers

List <- list(Vec, Mat)

Lists
An ordered collection of objects 
(components). A list allows you to gather a 
variety of (possibly unrelated) objects 
under one name.



Assigning variables syntax

VariableName <- c(“something”, “something else”)
1. Variable name
2. <- (smaller then, hyphen)
3. c: combines arguments
4. Round bracktets open
5. Your arguments, number, texts, variables, …
6. Round brackets closed

Generic

Now_arr <- as.array(variable)
Now_Mat <- as.matrix(variable)
Now_vect <- as.vector(variable)
Now_df <- as.data.frame(variable)
Now_list <- as.list(variable)

is.array(variable)
is.matrix(variable)
is.vector(variable)
is.data.frame(variable)
Is.list(variable)

Want to know? Want to convert/to be sure?



Things to do

1. Import your data (CSV, XLS, …)
2. Look at the data
3. Organize your data / extract parts of it
4. Do statistics on it
5. Plot (parts of) the data + make the plots look good
6. Correlate your data, model it
7.   Output data, plots, ect…  



Importing csv, xls, … in R

In the environment: Import dataset > text base
1. Use heading if available
2. Press import: the table will be shown
3. In the console, you see the commands you (graphically) used

Results <- read.csv("C:/Users/vanheckd/Desktop/scripting/Results.csv")

Also possible: 
- XLSX, TXT, HTML, and other Common Files into R
- JSON, XML Files
- SAS, SPSS, and Other Datasets into R
- Stata Files
- Systat Files
- Minitab Files
- RDA or RData Files
- Directly read Databases (mySQL, …) from the internet 
- Import through  Webscraping



Look at your data (assuming number data)

Summary(Results)Get a summary: 

Summary(Results$Feret)Get one column: $

Results$FeretSee all data: 

Or Environment > Data > doubleclick “Results”



Organize your data (assuming number data)

Filter for values: 

FilteredResults <- Results[Results$Feret < 25,]
Filteredferet <- FilteredResults$Feret[0:particles]
Filteredminferet <- FilteredResults$MinFeret[0:particles]
NewResultsFiltered <- data.frame(Filteredferet, Filteredminferet)
colnames(NewResultsFiltered) <- c("Feret", "MinFeret")

hist(NewResults$Feret)

particles=1000
feret <- Results$Feret[0:particles]
minferet <- Results$MinFeret[0:particles]
NewResults <- data.frame(feret, minferet)

Select first n values: 

1000length(NewResults$feret)

newVar <- Results$Feret[firstValue:lastValue]

newVar <- Results[Results$Feret < 25,]

Plot a histogram:



Do statistics

Many statistical test in the base package, with many more to download: 

#Normality test
shapiro.test(feret)
shapiro.test(minferet)
length(minferet)

- Two-sample differences tests (e.g. t-test).
- Non-parametric tests (e.g. U-test).
- Matched pairs tests (e.g. Wilcoxon).
- Association tests (e.g. Chi squared).
...

packages.install(“ggplot2”)

library(ggplot2)

Installing and loading packages:

Common R packages:
ggplot2 (Grammar of Graphics) 
data.table   
dplyr
tidyr

popular data visualization library.

fast handling a vast amount of data (up to 100GB)
data manipulation
helps to create tidy data (see also: Tidyverse)



Plot data
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